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Abstract

Period04, an extended version of Period98 by Sperl (1998), is a software
package designed for sophisticated time string analysis. In this article we
present the User Guide for Period04.
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1. Introduction

Period04 is a computer program especially dedicated to the statistical analysis
of large astronomical time series containing gaps. As its predecessor, Period98,
the program offers tools to extract the individual frequencies from the mul-
tiperiodic content of time series and provides a flexible interface to perform
multiple-frequency fits.

Fundamentally, the program is composed of 3 modules:

e The Time String Module
Within this module the user administrates the time string data. The
module contains tools to split a data set into substrings, combine data
sets, set weights, etc.

e The Fit Module
Least-squares fits of a number of frequencies can be made in this module.
Apart from basic fitting techniques, Period04 also contains the possibility
to fit amplitude and/or phase variations, or to take into account a periodic
time shift. Furthermore, several tools for the calculation of uncertainties
of fit parameters, such as Monte Carlo simulations, are available.

e The Fourier Module
For the extraction of new frequencies from the data, this module is pro-
vided. The Fourier analysis in Period04 is based on a discrete Fourier
transform algorithm. We do not use a Fast Fourier Transform (FFT)
algorithm as astronomical time string data sets usually are not equally
spaced.

Some tools or functions are only accessible when the program operates in
the so called 'Expert mode'. A detailed description of the expert mode can be
found in section 2.12.

Period04 is project oriented and saves all data (time string data, Fourier
spectra, frequencies and the log) in one central project file. The project file
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itself is completely platform independent. This allows the user to switch between
various operating systems. As the program also stores the current program
settings along with the data, it is easy to resume work on a project.

1.1 Backwards compatibility

Period04 is based on Period98 by Sperl (1998). Period98 project files (.p98) can
be read by Period04 without any problems. The default extension for Period04
project files is .p04 though.

1.2 Obtaining Period04

Period04 is freely available and has been compiled for Linux, Windows and
MacOSX. The program can be downloaded from the Period04 website:
http://www.astro.univie.ac.at/ dsn/dsn/Period04/.

The installers will guide you through the installation process.

1.3 Requirements

Period04 is a Java/C++ hybrid program. Therefore, to run the program a
Java Runtime Environment (JRE) has to be installed. The JRE is already
preinstalled on every Mac OS X System. Windows and Linux users will have
to check if there already exists a JRE on their system. To do that simply
open a shell or a command prompt and type 'java -version’ If the command
is not found no Java is installed. In this case you have to download it from
http://java.sun.com/getjava. It is free. If the 'java’ command exists, please
check the version number. The Period04 binary works with all versions from
1.4.2.
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2. The Graphical User Interface

In this chapter the Period04 User Interface will be explained in detail.

2.1 The main window

The main window of Period04 consists of 3 parts: the menu bar at the top, the
status bar at the bottom and a tabbed frame in the center. The tabbed frame
contains 4 folders:

Time string a module for the management of time string data

Fit a flexible interface for least-square fitting
Fourier a module for the calculation of Fourier transforms
Log contains the protocol of all actions taken

The '"Time string’ folder is activated by default after start-up.

2.2 The menu bar

The menu bar gives access to 3 menus (File, Special and Help) in default mode,
whereas in the expert mode an additional menu entry, Options, is available. See
Section 2.12: 'The expert mode' for more details on additional features.

2.2.1 The 'File' menu

Figure 1: The 'File’ menu
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¢ New Project
This command closes the current project and creates a new empty project.

e Load Project
Use this command to open an existing Period04 (or Period98) project
file. The file extension of Period04 projects is '.p04".

e Save Project
Save the complete project (time string data, frequencies, Fourier spec-
tra,...) into a file. If you save the project for the first time you will be
asked to provide a name and a path for the file. Thereafter, each time
you save, the changes will automatically be written to this file.

e Save Project As
Provides the possibility to save the current project under a different name.

¢ Recent project-files
Gives instant access to up to 10 recently edited projects. The file paths
of projects are saved in a file named '.period04-recentfiles’ which can be
found in the user directory.

e Import
This menu entry contains the following entries:

— Import time string:
Imports a time string from a file. If the project already contains
time string data the user will be asked whether he wants to erase
the old time string. Please see section 4.1.1 for further details on
this topic.

— Import frequencies:
Import frequencies, amplitudes and phases from a file.

e Export
The 'Export’ menu entry holds three items:

— Export time string:
Saves selected data columns into a file. Please see section 4.1.2 for
further details.

— Export frequencies:
Saves frequency data into a file.

— Export log file:
Saves the protocol into a file.
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e Manage Data (available in expert mode only)
This command opens the Data Manager (section 2.13), a tool to edit
project data.

o Expert mode
If the 'Expert mode’ check box is selected, you will have access to addi-
tional tools (see section 2.12). This option is by default deselected.

o Quit
Quits the program. If the project has changed since the last backup the
user will be reminded to save the project before closing the program.

2.2.2 The 'Special’ menu

The special menu contains tools related to time string management, least-
squares fitting and Fourier noise calculations.

Figure 2: The 'Special’ menu in expert mode

o Weight selection
Starts a dialog for activating weights. The chosen weight selection will
be used in Fourier calculations as well as in least-squares calculations.
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Time string related menu entries:

e Subdivide time string
Opens a dialog to divide the time string into substrings.

e Combine substrings
Opens a dialog to combine substrings.

e Calculate Nyquist frequency (available in expert mode only)
Calculate the Nyquist frequency for a user-defined time range.

e Show time structuring
Show some information on the time structuring of the current time string.

e Adjust time string
Opens a dialog for adjusting zero-point variations.

e Set default label for deleted points
Opens a dialog to define the default name and the attribute of the sub-
string in which deleted data points will be put.

e Delete selected points
Deletes all points belonging to the currently selected time string irrevo-
cably.

Menu entries related to least-squares fitting:

e Select all frequencies
Selects all frequencies in the Fit Module.

e Deselect all frequencies
Deselects all frequencies in the Fit Module.

e Clean all frequencies
Cleans the frequency list in the Fit Module.

e Calculate epochs
Calculates the times of epochs for every active frequency.

e Recalculate residuals
Recalculate the residuals using the current selection of time points and a
user-defined zero point.

e Predict signal
Predict the magnitude or intensity at a specific time according to the
current fit.
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e Create artificial data
Opens a dialog for creation of artificial data.

e Set alias-gap
Opens a dialog to set the step size for frequency adjustments.

e Show analytical uncertainties
Opens a window that displays the parameter uncertainties based on the
assumption of an ideal case.

Menu entries related to Fourier calculations:

e Calculate noise at frequency
Opens a dialog to calculate the noise at a specific frequency.

e Calculate noise spectrum
Provides a tool to calculate a noise spectrum.

2.2.3 The 'Options’ menu (available in expert mode only)

Figure 3: The 'Options’ menu

e Set fitting function
Period04 contains the possibility to change the fitting formula. Apart
from the default calculation mode, a fit including a periodic time shift
can be made.

2.2.4 The 'Help’ menu

e Period04 Help
Launches the Period04 help system.

e Topics
Gives access to certain Period04 topics in the help system.

e Tutorials
Launches the help system and shows the main page for the tutorials.
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Figure 4: The "Help’ menu

e Shortcuts
Opens a page that lists all shortcuts that are supported by Period04.

e Period04 - Homepage
Launches a web browser and navigates to the Period04 homepage.

e Report a bug
Provides instructions for the submission of bugs.

e Copyright
Displays the copyright notice.

e About
Displays some information (i.e., the version number) about your copy of
Period04.

2.3  The status bar

The status bar shows additional messages to inform the user of the status of the
program. In case of File /O actions a progress bar is displayed that indicates
the progress of the task.

2.4 The 'Time string’ tab

The Time String Module is dedicated to edit time string data. In the upper
part of the 'Time string’ tab buttons for loading and saving time string data
are located:
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Figure 5: The status bar showing its default message.

Figure 6: The status bar showing the progress while loading a project.

e Import
Import time string data. If the current project is not empty, then the old
time string data will be replaced and the remaining project data (frequen-
cies, Fourier spectra and the log) will be erased.

e Append
Add a time string to the time string of the current project.

e Export
Save time string data to a file.

The text box next to the buttons contains the full path-names of the files
from which the data have been imported. Below the text box some properties
of the currently selected time string are shown:

e Points selected
The number of points that are currently selected.

e Total points
The total number of points in the time string.

e Start time
The lowest time value of the currently selected time string.

e End time
The highest time value of the currently selected time string.

e Check box 'Time string is in magnitudes’
If your data are in magnitudes instead of intensity this option should
be selected. In case of magnitudes the y-axis of time string plots will be
reversed — it is also important for correct epoch calculation. By default the
program assumes that the data are in magnitudes. It is possible to change
the default setting by editing the Period04 preferences (section 2.11).
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Figure 7: The 'Time string’ tab.

The main part of the 'Time string’ folder is made up of 4 list boxes. Each
list box represents an attribute for the time string data. If you did not read in
any attributes then the lists will show the entry 'unknown’. The names of the
attributes can be changed by clicking on the headings on the top of the lists.
You may also change the default names by editing the preferences file.

In the lower part of the Time String Module there are several buttons:
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e Edit substring
Click on this button to edit the properties (name, color and weight) of
the currently highlighted items (substrings) of the list. See section 2.8.9
for further details.

e Display table
Displays a list containing the full information on all data points of the
selected time string.

e Display graph
Plots the selected time string and, if the resolution of the viewport is high
enough, shows the current fit as well.

The columns in the Time String Module provide a pop-up menu too. The
following entries are currently available:

e Edit substring properties
Opens a dialog to edit the properties of a substring.

e Select all substrings
Selects all substrings in the current list box.

Figure 8: The pop-up menu for the list boxes in the Time String Module

2.5 The 'Fit’ tab

The 'Fit’ folder itself contains two tabs:

¢ Main
The 'Main’ tab contains the frequency list, a panel to define the settings
for least-squares calculations and several buttons to start calculations.

e Goodness of Fit
This tab provides tools for the calculation of uncertainties.
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Figure 9: The 'Fit’ tab.

251 The Main tab

In the upper part of the 'Main’ folder buttons for loading or saving frequencies
are situated. If the frequencies are imported from an external file, the file to be
imported has to be formatted as shown below:

F1 8.245592 0.036872 0.191925
F2 8.866320 0.031595 0.201285
F3 (8.514142 0.009952 0.811823 )
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If the frequency parameters are enclosed by parentheses, the frequency will
appear inactive in the frequency list.

Furthermore, some information regarding the current fit is given:

e Selected frequencies
The total number of active frequencies. A frequency is active (and will
be included into calculations) when the respective check box is selected
in the frequency list.

e Zero point
The zero point of the magnitudes/intensities resulting from the last cal-
culated fit.

e Residuals
The residuals () for the last calculated fit.

To the left of the import/export buttons and to the right of the information
labels there is a toggle button, respectively.

Figure 10: The toggle buttons.

A click on the left hand side toggle button detaches the 'Time string' tab
from the main frame and places the 'Time string’ panel to the left of the main
frame, whereas a click on the right hand side toggle button causes the 'Fourier’
tab to be detached and placed to the right of the main frame.

If your screen is wide enough this makes it possible to use Period04 without
having to switch between the different tabs.

Settings for least-squares fit calculations:

¢ Fitting formula
Displays the formula that is being used for least-squares fits.
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¢ Calculations based on
This defines the type of data (Original or Adjusted) to be used for the
next least-squares calculation.

e Use weights
Displays a string that indicates which weights are being used for the
least-squares calculation. If no weights are used 'none’ will be displayed.

use the weights assigned to the substrings of attribute #1
use the weights assigned to the substrings of attribute #2
use the weights assigned to the substrings of attribute #3
use the weights assigned to the substrings of attribute #4
use point weight

use deviation weight

O T ~WDNR

o Edit weight settings
Opens the weight-selection dialog.

The frequency list:

In the default mode the frequency list consists of input fields for frequency,
amplitude and phase values and corresponding check boxes. If a check box is
selected, then the respective non-zero frequency will be included in the next
least-squares calculation.

Input options for frequency fields:

It is possible to enter harmonics or frequency combinations into frequency
fields as shown in the examples below:

=2f1 or =2%f1 for the second harmonic of fl.

=f1+f3 for a combination frequency which is defined as
the sum of f1 and f3.

=2f1-3f4 for a combination frequency which is defined as
or =2xf1-3xf4 the difference of the second harmonic of f1 and
the third harmonic of f4.

Please note:
A reference to a frequency, which is a combination itself, will be rejected by the
program. If one of the frequencies listed in the combination is not active, the
combination is not active either.
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If a frequency is a combination, a little button showing the letter 'C" will
appear between the frequency check box and the frequency input field. Click
on this button to show the frequency value instead of the combination string
and vice versa.

Figure 11: Example for an example combination frequency

Adding or subtracting the alias-gap value:

In order to add the alias-gap value to the frequency value, enter a trailing
'+'. Type '-' if you want to subtract the alias-gap value. Multiple '+" or -’
can also be used, e.g., '34.11+++" means 34.11 with three times the alias-gap
value added. The default value for the alias-gap can be set by using the 'Set
alias-gap dialog’ (section 2.8.14).

Extensions for the periodic time shift mode (available in expert mode only)

See also section 4.3.3: 'Using the periodic time shift mode' for an instruction
on how to activate this option. If the periodic time shift (PTS) mode is active
the frequency list is extended to contain input fields for the periodic time shift
parameters.

Figure 12: The frequency panel in the periodic time shift mode.
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Furthermore, two additional buttons are available:

e Search PTS start values
Searches for a good start value within a given range by means of Monte
Carlo shots.

e Improve PTS
Starts a least-squares calculation to improve the time shift parameters.
For this calculation all three parameters of the periodic time shift will be
improved, while the parameters of all other frequencies will be kept fixed.

Please note:
For the periodic time shift mode the buttons for showing the phase plot and
the calculation of amplitude and/or phase variations will not be available.

2.5.2 The 'Goodness of Fit’ tab

In this tab the uncertainties of the parameters can be calculated. See 'Estima-
tion of uncertainties’ (section 4.3.4) for further details.

¢ Info
Launches the Period04 help system and shows a page with some in-
formation on how to use Period04 to estimate the uncertainties of fit
parameters.

o Calculate LS uncertainties
Calculates either correlated or uncorrelated uncertainties for the fitted
parameters via a least-squares calculation.

e Monte Carlo Simulation
Opens a dialog which allows for the calculation of uncertainties for the
fitted parameters by means of a Monte Carlo simulation.

e Print list
Prints the content of the text field.

e Export list
Opens a file-selector to save the content of the text field to a file.
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Eesults of the Least-Sguares-Fit:

ChiSquare: 0. 2131364930
Feduced Chi Square: L. 7EZ21125868-05
Fesiduals {Chi): 0008241427417

Zeropoint: 2.935538590
Uncertainty: 000014 TEE85701

Freqg. signa AnpT, sigma Pha. ‘sigma
(B24161171e-~05 0.0002140546931, 0000034546591
L 3AEETETESe-05 0 0002109400338 - 0. 001058629783
0001087490688 0.0002099283835 0. 003471127491
LOOO1ZB0B37EZ5 0. 0002181462750 0, 0039853234571
SO0019211388 74 0U0002123IETR02Y 0006045384645

Figure 13: The 'Goodness of Fit' Tab

2.6 The 'Fourier' tab

The 'Fourier' folder basically consists of two parts:

e a panel for the Fourier calculation settings

e a list box that contains all Fourier spectra calculated so far.
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1 {F==8.24525125, A=0.0342032041 )

2 ([ F=8.8661231%, A=0.030672417)

3 {F=8.51415808, A=0.0100963423 }

Figure 14: The 'Fourier’ tab.

The Fourier calculation settings panel

o Title
Defines the name of the Fourier spectrum.

e From / To
Defines the frequency range for the spectrum.
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e Step rate
Defines the accuracy of the frequency grid for the Fourier calculation.
Three default options for the step rate quality are available and can be
selected by the combo-box: High, Medium and Low. In order to set a
user-defined value, select 'Custom’ and type the desired value into the
input field next to the step rate combo-box.
Please note: The smaller the step rate the longer the calculation will take.

¢ Nyquist
Displays the Nyquist frequency for the time string that is currently se-
lected. This value should be a good estimate for the upper frequency
limit due to the sampling pattern for the current data set. The algorithm
estimates the average time gap between neighboring points while ignoring

large gaps.
e Use weights

Displays a string that indicates which weights are being used for the
Fourier calculation. If no weights are used 'none’ will be displayed.

use the weights assigned to the substrings of attribute #1
use the weights assigned to the substrings of attribute #2
use the weights assigned to the substrings of attribute #3
use the weights assigned to the substrings of attribute #4
use point weight

use deviation weight

O T WK

o Edit weight settings
Opens the weight-selection dialog.

e Calculations based on
Defines the type of data to be used for the calculation: 'Original data’,
'Adjusted data’, 'Residuals at original’ or 'Residuals at adjusted’. If 'Spec-
tral window' is chosen the program will calculate the spectral window
which is centered at zero frequency and reflects the pattern caused by
the structure of gaps in the time string.

¢ Compact mode
The output of the Fourier calculation can be quite extensive. To reduce
the output 'Peaks only' can be selected. In this case only local maxima
and minima are saved. If 'All’ is selected, all data points of the spectrum
are stored.

To start the calculation based on the settings in the Fourier Module either
press the button 'Calculate’ or type the shortcut 'Alt+C'.
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The Fourier list

All calculated Fourier spectra are listed in the Fourier list box. For every
spectrum the title of the spectrum and, in parentheses, the frequency and am-
plitude of the highest peak is given. By selecting a spectrum the settings for
that calculation will be loaded and displayed.

The buttons below the list provide the following functions:

¢ Rename spectrum
Change the title of the highlighted Fourier spectrum.

e Export spectrum
Save the data points of the highlighted Fourier spectrum into a file. In
order to export a set of spectra the Data Manager should be used.

e Delete spectrum
Erase the highlighted Fourier spectrum.

¢ Display table
Show the table of data points for the highlighted Fourier spectrum.

e Display graph
Show the highlighted Fourier spectrum as a plot on the monitor.

Please note:
The functions of these buttons are also accessible by a pop-up menu.

2 (F=886812312, A=0030672417)

4 (F=7.42476435, A=0.00779550437 )

Figure 15: The pop-up menu for the Fourier list.
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2.7 The 'Log’ tab

Period04 logs all actions taken. It is possible to edit, print or save the log.

Lenz and M. Breger
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Figure 16: The 'Log’ Folder
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2.8 Dialogs
2.8.1 The 'Weight selection’ dialog

In the 'Weight selection’ dialog the user selects the weights that should be used
for Fourier and least-squares calculations. Multiple selections are possible. See
'"Using weights’ (section 4.4.1) for a detailed description of setting weights.

Figure 17: The '"Weight selection’ dialog

Period04 supports 3 types of weights:

e weights assigned to the substrings of an attribute
If you decided to give your substrings different weights in one or several
of the four attributes and you want to include them in the calculations,
then select the appropriate attribute weight.

e point weight
If you read in a point weight for each of your data points and want to
use them in your calculations, then select this weight.

e deviation weight
If this option is active the data points will be weighted based on their
residual value. 'Cutoff' defines a limit residual value. If the residual of
the data point is within this limit, then its weight is set 1.0, otherwise
the weight will be calculated based on the residual and the cutoff value.

2.8.2 The 'Subdivide time string’ dialog

To split the time string into subgroups based on times of measurements select
'Subdivide time string’ in the 'Special’ menu. Period04 offers two alternative
ways of dividing a time string into substrings. The dialog box prompts the user
to choose the desired type of subdivision:
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Figure 18: The 'Subdivide data’ dialog

e Subdivide by gaps
The program will search for time gaps between consecutive points that
are larger than a user-defined value. The data set is then subdivided by
these gaps.

e Subdivide by fixed intervals
If you want to divide the time string into substrings using a fixed time
interval then select this option.

According to your selection one of the dialogs shown in Figs. 19 and 20 will
open. Below the dialogs an appropriate time string plot shows the difference
between the two kinds of subdivisions applied to one and the same data set:

For a subdivision the following informations are needed:

e Size of the gap
Defines the minimum gap size (using the same time unit as your time
string). If two consecutive points are separated more than the given
value then a subdivision will be made.

e Start time
Only data points after this time value will be subdivided. Defaults to the
lowest time value of the time string.

e Time interval
Defines the length of the interval for the subdivision.

e Choose the attribute you want to subdivide
Defines the attribute (column) in which the subdivision should take place.

e Label prefix
The final labels of the substrings are constructed in the following way:
[prefix] + [average time of the substring]
Here you can define this prefix.
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Figure 19: Subdivide by Figure 20: Subdivide by
gaps fixed intervals

B @ EID.
Ry BRI
R0 DI S B

Figure 22: An example

Figure 21: An example for 'Subdivide by fixed in-
for 'Subdivide by gaps’ tervals'

¢ Use running counter
If this option is selected the program constructs the final label of the
substrings in the following way:
[prefix] + [a running counter]

e Decimal places to use from time
The number of digits that will be used for the labels of the substrings.

2.8.3 The 'Combine substrings' dialog

This is the inverse operation to 'Subdivide time string’ (section 2.8.2). In order

to combine a number of substrings first highlight the substrings you want to join.

Then open the 'Combine substrings' dialog (Special / Combine substrings).
Two values have to be defined:

e Attribute
Select the attribute in which the substrings should be combined.
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Figure 23: The 'Combine substrings’ dialog.

e New name
Enter the name for the resulting substring in this field.

2.8.4 The 'Show time structuring’ dialog

This dialog displays some information on the structure of the time string. For
every substring of the selected attribute the following data are given:

e Start / End time
e Length
e Mean time

e Number of points that belong to the substring

439976 JS4B63T
197734 928945
345848 AS51541
O 2E65E L0447 2
032925 LB99355
351456 . 336159
G39655 LFFTOES
335232 LB37055
Q02125 .921314
BI7H40 .E54243

1514.85705% -1515.042053
1515.754154 1516.042405
1516.8%92113 1517.031570
1517.7785833 -1518.029945
1519, 773620 1520.024992
1820.316325 1520.955972
1523, 759576, 1523.794563
1524,830060° 1524.5449023
1525,302460° 1526, 010882
D1530 1529, 748070 1530035480

T D D e Oy ok T s

otal observing time [hrsl: 42,4708
atal mean. tine: 1519.820982

Figure 24: The 'Show time structuring' dialog.
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Finally the total observing time and the total mean time of the time string
are given. If "Time unit is in days’ is selected, the length of the substrings and
the total observing time will be converted into hours, otherwise they will be
given using the same time unit as your time string.

The content of the text area can be printed and saved to a file by clicking
on the appropriate button at the bottom of the dialog.

2.8.5 The 'Calculate specific Nyquist frequency’ dialog (available in expert
mode only)

Sometimes it is useful to calculate the Nyquist frequency based on data points
within a specified time range. To open the dialog choose 'Calculate specific
Nyquist frequency’ from the 'Special’ menu.

Figure 25: The 'Calculate Nyquist frequency’ dialog.

Enter the desired time range and press 'Calculate’ to get the appropriate
Nyquist frequency.

2.8.6 The 'Adjust time string’ dialog

It might occur that your substrings have marginally different zero-point offsets
in magnitude/intensity. This can be caused by different instrumentation, or
different observational conditions for these substrings.

Zero-point variations entail additional noise in the low frequency domain.
To reduce this noise source, one has to adjust the zero-point offsets. This can

be done through the 'Adjust time string’ dialog.

Before you open the dialog, however, you should calculate a fit as this rou-
tine uses the residuals to calculate the zero-point offsets. Select the appropriate
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Figure 26: The 'Adjust time string’ dialog.

attribute to show the set of given substrings. If weights should be used to cal-
culate the average and the sigma values then select 'Use weights’.

In the list several columns are shown:

e Label
The name of the substring.

e Observed or Adjusted
Shows the mean value of Observed or Adjusted, respectively.

e Sigma(Obs./Ad;].)
Shows the deviation of Observed or Adjusted.

e Points
The number of points that belong to the given substring

e Adjusted
If this column contains the entry 'Yes' some or all points of the specific
substring have already been adjusted.

In order to adjust the data, select the substrings and press 'Adjust’. The
result will be displayed. You may export or print the content of the text box by
pressing the appropriate button.

Please note:
Remember to select "Adjusted data’ for all further calculations!
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2.8.7 The 'Set default label for deleted points' dialog

By default Period04 does not delete points directly, but adds them to a substring
labeled as 'deleted’ in the attribute 'Other’. As the user might prefer other
settings, the label and the position (that is the attribute) can be changed using
this dialog. To open the dialog select 'Set default label for deleted points' in
the 'Special’ menu.

Figure 27: The 'Set default label for deleted points’ dialog.

e Put deleted points as attribute
Defines in which attribute the substring containing the deleted points will
appear.

e Label to use for deleted points
Defines the default name for the substring that contains the deleted
points.

After pressing 'OK' the new settings will take effect.

2.8.8 The 'Relabel data point’ dialog

The 'Relabel data point' dialog appears through a click with the right mouse
button on a data point in a time string plot. It is also accessible via the pop-up
menu of the time string data table.

Figure 28: The 'Relabel data point’ dialog.
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Using this dialog it is possible to change the labels for the chosen point in
each attribute. For clarification: the label refers to the name of the substring
that includes this point.

2.8.9 The 'Edit substring’ dialog

Figure 29: The 'Edit substring’ dialog.

The 'Edit substring’ dialog can be accessed through the 'Edit substring’
buttons on the 'Time string’ tab or by using the pop-up menu of the attribute
lists. This dialog (Fig. 29) shows the current properties (name, weight and
color) of the substring.

Name refers to the label of the substring that currently contains this point.
Weight assigns the given weight to all points of the selected substring. See
'Using weights’ (section 4.4.1) for more information on using weights for cal-
culations. Color defines the color of this substring to be used for plots.

2.8.10 The "Calculate epoch’ dialog

To calculate the epochs close to a given time open 'Calculate epoch’ in the
'Special’ menu. Please note that this calculation is based on the last fit.
It is possible to calculate the time of either

e Maximum light (maximum intensity, respectively)
e Minimum light (minimum intensity, respectively)

e Zero point, the time when the fit crosses the average of the fitted function
(1/4 period before the maximum light).

Note that the program already knows whether you are using magnitudes
(maximum light at minimum value) or intensities.
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127162156
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Figure 30: The 'Calculate epoch’ dialog

The values for the epoch will be evaluated close to a given time, that has
to be entered into the respective input field.

After pressing 'Calculate’, the results will be displayed in the text box. The
first column is the frequency number, the second column shows the value for
the frequency and finally, in the last column the time of the epoch is displayed.
You may export or print the content of the text box by pressing the appropriate
button at the bottom of the dialog.

2.8.11 The 'Recalculate residuals’ dialog

For the purpose of recalculating the residuals using an other zero-point, select
'Recalculate residuals’ in the 'Special’ menu.

Figure 31: The 'Recalculate residuals’ dialog

Enter a new zero-point value into the input field and press 'OK’ to start the
calculation.
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2.8.12 The 'Predict signal’ dialog

If you want to calculate the signal at a given time, open the 'Predict signal’
dialog (Special / Predict signal).

Figure 32: The 'Predict signal’ dialog

The dialog displays the start time of the currently selected time string. Be-
low this line a specific time can be entered at which the signal will be calculated
based upon the last fit. After pressing 'Calculate’ the result will be shown.

2.8.13 The 'Create artificial data’ dialog

Period04 also supports the creation of equally spaced artificial data. If desired
even a periodic time shift can be included. You may also refer to 'Creating
artificial data’ (section 4.1.3) for a step-by-step guide about how to use this
feature.

Figure 33: The 'Create artificial data’ dialog

e Start-time / End-time
Defines the time range for which data should be generated.

¢ Read time ranges from file
Press this button to read in multiple time ranges from a file. Such a file
should contain two columns: in the first column the start times should
be given and in the second column the respective end times.
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e Step
Period04 will create data points that are equally spaced in time. This
field defines the step size in time.

e Leading/trailing time
If this option is non-zero the time range(s) will be extended by the given
value.

Before the generation of the artificial data set starts, a file name has to be
specified in which the output will be written. Press "Write data to the following
file' and define the name and the path of the file in the file-selector dialog. If
the file already exists the user will be prompted whether he wants to append
the data to the existing file or to replace the file.

2.8.14 The 'Set alias-gap’ dialog

The alias-gap dialog allows for the definition of the step size for frequency ad-
justments. This value will be added or subtracted from a frequency when you

enter a trailing '+' or '—' to the respective frequency in the frequency list of
the Fit Module.

To open this dialog select 'Set alias-gap’ from the 'Special’ menu. After
changing the old value and pressing 'OK’ the new settings will take effect.

Figure 34: The 'Set alias-gap’ dialog

2.8.15 The 'Show analytical uncertainties’ dialog

This dialog displays the parameter uncertainties calculated from formulae which
assume an ideal case. See Breger et al. (1999) for the derivation of uncertainties
for frequency, phase and amplitude based on a mono periodic fit. If cross
terms can be neglected the equations can also be applied for each pulsation
frequency separately. See 'Estimation of uncertainties’ (section 4.3.4) for more
information.
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Figure 35: The 'Show analytical uncertainties’ dialog

You may export or print the content of the text area by pressing the appro-

priate button at the bottom.

Please note:

This option is only available when the standard fitting formula is being used.

2.8.16 The 'Improve special’ dialog

The 'Improve special’ dialog appears when you press the 'Improve special’ but-

ton in the Fit Module.

F1 24552165
r2. 886629795
F3 851400244
P4 74244122
£S5 10427036

Fl 0.0385429379
F2-0.0308253197

F3 000953713964
F4 000783237408
FS 000544374494

F1 0304153
F210.236373
F30.0260293

Figure 36: The 'Improve special’ dialog

The dialog consists of three list boxes that contain all currently available
frequency, amplitude and phase parameters. Select the parameters you want
to improve and press 'OK’ to start the least-squares calculation. Unselected

parameters will be kept fixed.
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2.8.17 The 'Calculate amplitude/phase variations’ dialog

This dialog opens up when you press the 'Calculate amplitude/phase variations'
button in the Fit Module. It offers the possibility to calculate amplitude and/or
phase variations. Please also see 'Calculating amplitude/phase variations' (sec-
tion 4.3.2) for a step-by-step guide on how to use this tool.

frequency=8.24552165
frequency=8.556297495
frequency=8.51400244
frequency=74244122
frequenicy=10.42 7036

Figure 37: The 'Calculate amplitude/phase variations’ dialog

Calculation settings:

e Attribute to use:
Defines the attribute that contains the time string subdivision that should
be used for the calculation.

e Type of variations:
Select either "amplitude variations', 'phase variations' and "amplitude and
phase variations’ here.

¢ Parameters to improve:
By default option 'all ampl. & phases’ is selected. That means that for
this calculation the frequencies will be kept fixed and all amplitudes and
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phases are redetermined. To specify a different selection click on 'special’
and make your choice in the selection dialog that will be opened.

Press 'Calculate’ to start the calculation using the defined settings. The
results will be displayed in the text field. You may print or export the results to
a file by clicking the appropriate button at the bottom.

2.8.18 The 'Monte Carlo simulation’ dialog

This dialog is shown when you click on Monte Carlo Simulation in 'Goodness
of Fit' tab in the Fit Module. It provides an interface for estimating the uncer-
tainties of fit parameters by means of Monte Carlo simulations.

Figure 38: The 'Monte Carlo simulation’ dialog

For the Monte Carlo simulation the program generates a set of time strings.
Each data set is created as follows:

e The times of the data points are the same as for the original time string.

e The magnitudes (or intensity) of the data points are calculated from the
magnitudes predicted by the last fit plus Gaussian noise.

For every data set a least-squares calculation will be made. Based on the
distribution of fit parameters the program calculates the uncertainties of the
parameters.

¢ Number of processes
A 'process’ consists of the creation of time string data and a least-squares
calculation to determine the fit parameters. A low number of processes
results in a bad estimate of the uncertainties. Therefore, a high number
of processes is highly recommended to obtain reliable results.
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e Uncouple Frequency and Phase Uncertainties
Frequency and phase uncertainties are correlated. If this option is selected
the time string will be shifted in time so that the 'average time' is zero.
If this condition is fulfilled, the frequency and phase uncertainties are no
longer correlated. This check box will only be visible if this option might
be useful, that is when both frequency and phase parameters are fitted
using the standard fitting formula.

e Use system time to initialize random generator
If this option is selected the random number generator that is used to
create the time string data sets will be initialized with the current system
time.

Please see 'Estimation of uncertainties’ (section 4.3.4) for further informa-
tions.

2.8.19 The "Calculate noise at frequency' dialog

In order to check the significance of a detected frequency it is necessary to
calculate the signal to noise ratio. For this purpose select 'Calculate noise at
frequency’ in the 'Special’ menu.

10.427036 0,000803168305

Figure 39: The 'Calculate Noise at Frequency’ dialog
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e Calculate noise at Frequency
Defines the frequency for which the noise should be calculated. The
frequencies that are stored in the frequency list in the Fit Module are
accessible by the combo-box below the frequency field. By default the
last frequency of the frequency list is activated.

e Box size
Determines the size of the frequency range to be used for the noise cal-
culation: [frequency — Y2E8E€ | frequency + 20232

e Step rate
Defines the accuracy of the frequency grid for the Fourier calculation.
Three default options for the step rate quality are available and can be
selected by the combo-box: High, Medium and Low. In order to set a
user-defined value, select 'Custom’ and type the value into the input field
next to the step rate combo-box.
Please note: The smaller the step rate the longer the calculation will take.

e Calculations based on
Defines the type of data to be used for the calculation: 'Original’ data,
'Adjusted’ data, 'Residuals at original’, 'Residuals at adjusted’ or 'Spectral
window'.

Click on "Calculate’ to start the calculation. The results of the noise calcula-
tion will be shown in the text field below. If the frequency has been selected via
the combo-box then even a value for the signal to noise ratio will be calculated.

You can export or print the content of the text box by pressing the appro-
priate button.

2.8.20 The 'Calculate noise spectrum’ dialog

Period04 also provides a tool to calculate a noise spectrum. The corresponding
dialog can be accessed via the Special menu.

This dialog is very similar to the 'Calculate Noise at Frequency' dialog.
However, for the noise spectrum the range and the step size have to be defined:

e Frequency range: from/to
Defines the frequency range for the noise spectrum.

e Spacing
In order to construct a noise spectrum the noise will be calculated for
certain frequencies in equidistant frequency steps. The 'spacing’ defines
the size of these frequency steps.
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Figure 40: The 'Calculate Noise Spectrum’ dialog

Click on 'Calculate’ to start the calculation. The resulting noise spectrum
data will be displayed in the text box below. To export or print the content of
this text box press the appropriate button at the bottom of the dialog.

2.9 Plots

Visual inspection of the data is very important. Period04 supports plotting on
the monitor of time string data, Fourier data and phase plots.

The menu bar for plot windows generally contains the following commands:

e The Graph menu:

— Print Graph
Opens a printer dialog for printing the plot using the current view-
port.

— Export Graph As (EPS/JPG)
Save the current plot as an image in eps or jpg format.

— Close
Close the plot window.
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e The Colors menu (not available for Fourier plots)
Every attribute has substrings which are assigned to a color. Using this
menu option it is possible to switch between the different coloring of the
four attributes.

e The Data menu (not available for Fourier plots)
Here you can select the type of data to be plotted: 'Observed’, 'Adjusted’,
'Residuals at observed' and 'Residuals at adjusted’.

e The Zoom menu:
— Display all
Resets the zoom.

— Select viewport
Opens a dialog to define the graph ranges.

— Freeze viewport (available for time string plots only)
If this option is selected the current viewport will be maintained,
unaffected of changes in the selection of substrings. Zooming func-
tionality is not affected.

— Back
Undo the last zooming action.

e The Help menu
provides a link to the help page for the appropriate plot.

The status bar

In the status bar of plot windows the current coordinates of the cursor will
be displayed, provided that the mouse cursor is situated within the plot domain.

Editing plots

The Scientific Graphics Toolkit that is being used for the plots allows to
edit some properties of the design:

e Labels
Change the text, font, color or position of the plot title and/or the axis
titles.

e Axes
Change label font, tic properties or the range.

To open the appropriate dialog, make a right-click on the appropriate label
or axis to activate it, then a left-click to open the dialog.
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2.9.1 Time string plots

To plot the currently selected time string, press the button 'Display graph’ in
the "Time string’ tab.

sdjurted
o

L1 i L il it %) L L L | L T
154580 154520 154650 . 154700 194740 154780

Figure 41: An example for a time string plot.

In this mode the menu bar is extended by an additional menu:

e The Display menu
In this menu the 'Display header’ option can be selected. If this option
is activated a header will be shown providing some information on the
current fit (number of frequencies, residuals, ...).

Editing the contents of time string plots:

¢ Relabel points
If you want to change the substring a particular point belongs to, click
on that point with the right mouse button. The 'Relabel data point’
dialog (section 2.8.8) will be shown. To prevent a wrong identification,
the dialog does only appear when the point is well separated from other
points.

e Deleting points
There are two ways to delete points:

— Press 'Ctrl’” and right-click on the point you want to delete.

— Draw a rectangle using the right mouse button. In contrast to zoom-
rectangles this rectangle is colored red. After releasing the button
the user will be prompted whether he wants to delete the points
within the rectangle or not.
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2.9.2 Phase plots

To show the phase plot press the 'Phase diagram’ button in the Fit Module.
By default the first found inactive frequency is being used for the plot. If no
inactive frequency can be found a default frequency value of 1.0 is chosen.
Please note: this option is not available within the periodic time shift mode.

king frequency: BE56398041

o 8% 8is

Figure 42: A typical phase plot.

Phase plots provide the two additional options which are accessible via the
'File’ menu:

e Export phases
Opens a time string export dialog which allows for saving the phases along
with other data.

e Export binned phases
Same as 'Export phases’ apart from the fact that binned phases are ex-
ported instead of phases.
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The frequency panel

e The frequency combo-box
Defines the frequency that is used for the plot. The combo-box contains
all inactive frequencies that have been found in the Fit Module. To
use a user-defined frequency value select 'Other Frequency' and type the
frequency into the input field next to the combo-box.

¢ Use binning
If this option is selected the data will be averaged for discrete phase
ranges. The input field next to the check-box defines the number of bins.

2.9.3 Fourier plots

To plot the currently selected Fourier spectrum, press the button 'Display graph’
spectrum in the Fourier Module.

My Fourikr calostat ion { F-8.24595129, = 0.0 343032041}

Figure 43: A common Fourier plot.

In the Fourier mode the menu bar is extended by one item:

e The Display menu
— Display Power
If this option is selected power will be plotted instead of amplitude.

— Display header
If this check-box is activated a header will be displayed containing
the title of the spectrum and the values of the highest peak.
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2.10 Tables
Period04 allows to inspect the data in table format too.
To display the time string table, press 'Display table’ in the "Time string’

tab. The table lists all selected data points along with information on residuals,
weights and the affiliation to substrings.

1514.860669 2 865350355 2963350353 297135073627 71!
1514864125 2.965715164 2:965715164 2957314 9432525
1514867572 2 860693923 12960893923 2962335748361 %
1514:871085 285474042 295474042 29564877057

1514; z522  B30104857
1514.588649 29215204 8 0449 12.9236039898098
1514:692099 280888378 2 308883781 2.9180795556675;
1514.895544 2.807375956 2, 907378956 28131807 502045
1514.898992 2.903604481 2:303504481 2.9091003043027
1514.502587 2.500184458 23001644532 2.9058236538642!
1514 505035 2601122942 2901122942 2. 903R7S401B128
1514.903488 2.904916203 (2:304816203 2.9025282444302
1514.012945 2.900415232 2900415232 2.9023719529865
1514 516543 2807036402 i2,907036402 2,8032200044

1514.919%86 2912853474 2:912853474 2904953672007
2913320503 2813320503 2.9074105632253
s x 3 RANTRALG

Figure 44: The time string table.

Within the Fourier Module it is also possible to inspect the values for fre-
quency, amplitude and power of a Fourier spectrum in form of a table. To
open this table select the respective Fourier spectrum and click on the button
'Display table'.

As the tables are available only for informative purposes the table itself can-
not be edited.

The menu bar for table windows contains the following entries:

e The Table menu
— Print Table
Use this command to print the complete table.

— Export Table
Save the content of the table to a file.

— Close
Close the table window.

© Austrian Academy of Sciences * Provided by the NASA Astrophysics Data System


http://adsabs.harvard.edu/abs/2005CoAst.146...53L

08 Period04 User Guide

458885312327 580911 74B801E-5 5.621875810938419E-0
BFFFORz4E53E4 1.53988083294E-4 3763176443724647E-8
0.00137665553655 2 BEEU50T4205E- 4 51564523501 41274E5
000183554124531 3 70008747587E-4 1.3764007071112254E-7
R VR 4 aBs 7071620754 E012156874384609E-7
0.00275331187398 5 1705230045E-4 2 673430907075785E-7
0.00321219718529 5. 75642524087E-4 2:313643155487652E-7
0.00367108245851 4.24075955001E 4 3 E94750464309517E-7
0.00412336781094 BEZT1159752E-4 4.391566614575105E~7
0 0H4SEEEE31 2327 G G255 55T 2GVE ¢ (4 79638767507 6315E-7
0.005047735843559 7.15298103885E-4 5116513774214 76 2E-7
0.00550662374792 7.33265903826-4 (5:3770B334066865IE-7
0 0E596550906025 7493522341 39E-4 5.615297708091107E-7
000§42439437257 7 66556331726E-4 S E76006097092214E-7
{0.0068532736840 7.B77EEB42703E-4 (6, 205T65984622532E-7
0.00734216495723 8 1517275914E-4 6.645066272439203E-7
0.00780105050655 B 4085764 3B15E-4 (7.222580147575824E-7
000825993562188 5. 0150AGE1EE7E-4 FB43267756013084E-7
0.0087188209342 9.35875322182E-4 18,614831151050656E-7
000917770624653 9892654535 5.786540120574111E-7
Sai i s e

Figure 45: The data table for a Fourier spectrum.

e The Help menu
Provides a link to the appropriate help page.

Within time string tables a pop-up menu is available:

¢ Relabel point
Gives access to the 'Relabel data point’ dialog (section 2.8.8) for the
selected time point.

e Delete point
Deletes the currently highlighted time point.
2.11 Period04 preferences

A new feature of Period04 is the preferences file. It is located in the user di-
rectory and it is named '.period04-pref’. At start-up Period04 searches for the
preferences file and reads in the default settings as defined in the file.

If the file is not found, the program shows a message reporting the problem
and creates a new file. The program also checks the file for defects. If the file
seems to be damaged or incomplete Period04 will ask the user if he wants to
delete the preferences file and to generate a new one or to proceed using the
internal default values.

By editing the ".period04-pref’ file the user can set the following values:

e default program mode (standard mode or expert mode)
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lower / upper bound for the default Fourier frequency range

default compact mode for Fourier calculations

default alias-gap value

default scale (magnitudes or intensity)

default names for the set of attribute names

default file-format for time string files

The user may also add own comments provided that the line starts with
'#'. This character advises Period04 not to read that line.

The default preferences file in detail:

#

# .period04-pref

#

# This is the Period04 preferences file. You can set

# your personal settings by replacing the default values.
# If this file is not found, Period04 creates a new one
# using its original settings.

#

#

PROGRAM_MODE DEFAULT

#

# start the program in the given mode
# possible values: DEFAULT

# EXPERT

#

DEFAULT_FOURIER_LOWER_FREQUENCY 0.0
#

# defines the default lower boundary
# of the frequency range for

# Fourier calculations

#
DEFAULT_FOURIER_UPPER_FREQUENCY 50.0
#

# defines the default upper boundary

# of the frequency range for

# Fourier calculations

#
DEFAULT_FOURIER_COMPACT_MODE ALL

defines the default setting for
Fourier calculations:
ALL = all data points of a Fourier
spectrum are saved
PEAKS_ONLY = only the maxima and
minima of the spectrum are saved

HoH OH H H R W R

DEFAULT_ALIAS_STEP DEFAULT
#

# defines the default alias step rate:

# DEFAULT = (1./365.)

# a user-defined number
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#
DEFAULT_SCALE_SETTING MAG
#

# defines the default scale setting:
# MAG = magnitudes
# INT = intensity

#

DEFAULT_NAME_SET [0] Date
DEFAULT_NAME_SET[1] Observatory
DEFAULT_NAME_SET[2] Observer
DEFAULT_NAME_SET [3] Other
#

# this defines the default attribute names

#

DEFAULT_TIMESTRING_FILE_FORMAT AUTO
#

# this defines the default file format for

# reading in time strings.

# AUTO = try automatic determination

# You may also enter a user-defined string,

# composed of the following letters:

# t ... time

# o ... observed

# a ... adjusted

# Cc ... calculated

# W ... point weight

# r ... residuals(observed)

# R ... residuals(adjusted)

# 1 ... attribute #1

# 2 ... attribute #2

# 3 ... attribute #3

# 4 ... attribute #4

# 5 ... weight(attribute #1)

# 6 ... weight(attribute #2)

# 7 ... weight(attribute #3)

# 8 ... weight(attribute #4)

# i ... ignore

2.12 The expert mode

If the expert mode of Period04 is activated, additional tools are available such
as:

o the Data Manager (see section 2.13)

e the possibility to calculate fits considering periodic time shifts (see sec-
tion 4.3.3)

e a tool to calculate the Nyquist frequency using specific time-ranges (see
section 2.8.5)

The expert mode can be activated by selecting the check-box 'Expert mode'
in the 'File’ menu. The expert mode setting is being saved in every Period04
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project file and will be reactivated automatically when the project is opened
again.

It is possible to start Period04 in the expert mode by default. For this
purpose you have to edit the Period04 preferences file which is located in your
user directory. Change the setting for 'PROGRAM_MODE’ from 'DEFAULT’
to 'EXPERT" as shown in this excerpt:

PROGRAM_MODE EXPERT
#

# start the program in the given mode

# possible values: DEFAULT

# EXPERT

From now, the program will always start in expert mode right away.

2.13  The Data Manager (expert mode only)

The Data Manager is a tool that combines all import and export data options
Period04 is capable of. It can be accessed via the menu bar (File / Manage
data) or using the shortcut 'Ctrl+M’, provided that the expert mode is acti-
vated (see section 2.12).

Figure 46: The 'Data Manager’

The Data Manager dialog is divided into 2 columns: the left column pro-
vides options for import, export and rearrangement of data. The right column
shows some information on the current project. The project information panel
will hide if an option in the left column has been selected. Instead, an other
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panel will be displayed, showing additional options for the selected action.

The project information panel:

e Time string data:

Clean Delete the complete time string.
Total points The total number of time points.
Points selected The number of currently selected time points.

e Frequency data:

Clean Delete all frequencies.
Active frequencies The number of selected frequencies.

e Fourier data:

Clean Delete all Fourier spectra.
Fourier spectra The number of spectra in the Fourier list.

e Project:

Save Save the current project.
Save as Save the current project using an other name.

If the project has changed since the last backup, a red warning label will be
displayed.

Options related to time string data:

e Append a new time string:
Choose this option if you want to add time string data to the current
project.

¢ Replace the old time string:
Erases the current time string and reads in a new time string. This option
does also provide the possibility prevent the automatic deletion of current
frequency data, Fourier spectra and the log.

e Rearrange time string data:
This option makes it possible to interchange time string data columns.
You may choose one of the following actions:

— replace 'Observed’ by 'Residuals(Observed)’
— replace 'Observed’ by 'Residuals(Adjusted)’

© Austrian Academy of Sciences * Provided by the NASA Astrophysics Data System


http://adsabs.harvard.edu/abs/2005CoAst.146...53L

— replace 'Observed’ by 'Calculated’
— replace 'Observed’ by 'Adjusted’

P. Lenz and M. Breger

103

By default the 'Adjusted’ column will also be replaced by the chosen

values whereas the 'Calculated’ values will be set zero.

e Export time string data:
Choose this option if you want to export time string data from the current
project to a file.

Options related to frequency data:

¢ Import frequencies:
Import frequency data from a file. Make sure that the file is formatted
as shown in this example:

F1
F2
F3
F4
F5

Unselected frequencies should be placed within parentheses.

12.716215
12.154121
24.227962
23.403372
(9.6562750

e Export frequencies:

Export frequencies from the current project to a file.

22.38070
4.034121
4.264320
3.816048
3.649441

Options related to Fourier data:

e Export Fourier spectra:
This option makes it possible to export either all or a specific selection of
Fourier spectra. According to the selection of the user, the program will
name the files either using the titles of the spectra or a composition of a
prefix and a running number.
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Figure 47: The 'Export Fourier spectra’ interface.

2.14 Overview of Shortcuts:

General Shortcuts:

Ctrl + N Create a new project

Ctrl + O Load an existing project

Ctrl + S Save the active project

Ctrl + T  Import/append a time string

Ctrl + A Adjust data

Ctrl + F  Import a set of frequencies

Ctrl + M Launches the data manager (available in expert mode only)
Ctrl + W Open the weight-selection dialog

Ctrl + Q  Quit the program

F1 Launch the Help System

Shortcuts only available in the 'Time string’ tab:

Alt + E  Export time string data
Alt 4+ D Display time string

Shortcuts only available in the 'Fit’ tab:

Alt + C Improve amplitudes and phases
Alt + |  Improve all parameters

Shortcuts only available in the 'Fourier' tab:

Alt + C Calculate Fourier transformation
Alt + D Display the selected Fourier spectrum
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3. Getting Started

The best way to learn how to use Period04 is by doing. For this reason we
created two example time strings which will be processed and discussed in the
tutorials below. The data files can be downloaded from the Period04 homepage:
http://www.astro.univie.ac.at/ dsn/dsn/Period04/

3.1 Tutorial 1: A first example

In this tutorial, we will use Period04 to examine a data set and determine the
frequencies by using Fourier analyses to give us rough values of the frequencies
and the Fit Module to refine these frequencies. Note that the Fourier analysis
cannot by itself solve the problem since it is a single-frequency method.

1. Start the program Period04.
You may wish to use the file 'Empty Period04 file.p04" which is part of the
downloaded data package. The tab 'Time string’ is selected and active.
You will see four empty columns.

2. Import the data set.
We will now load the data file. It has the name 'Tutoriall.dat’. Click
on the button 'Import time string’ (left, near top). A window opens and
asks for the location of the data. Find the proper directory on your hard
disk and click on the file name. Click on the button 'Import’.

Falialavs 0.355153256941
Felalas? 0.35552402128
72082194 0351394765361
720.82556 0.341021073205
TalE2ell 0323803759314
720.83268 0298271444756
72083625 0.265310021359
72083983 (.22570226520%
72084342 2181416187486
72064698 0135775612024
Faras056 0.0315455581877
Fanasalz 0.0528963035251

17208577 0.02306339322069

Figure 48: The 'Time string import’ dialog.
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A window opens and asks for the properties of each column. Since the
first data column is the time and the second columns contains the mag-
nitude variations, everything is fine. Click on 'OK".

(If not, under 'Column #1' etc. you can select the contents of each col-
umn.)

You now have 1254 data points loaded with observing times ranging from
2720.81478 to 2740.92739. Do not worry about the 'unknown’ labels in
each of the four columns: it just means that you have not organized your
data into groups.

Save your data now (File, Save Project as) under, say, 'First". It is now
stored as First.p04.

Look at the data.

In the same 'Time String’ window, click on 'Display Graph' at the bottom
right. A new window opens with the light curves of the selected data,
which, by default, was all the data. You notice that the data strings are
spaced one (or more) days apart.

Let us examine a (any) single night. With your mouse select a part of
the data by drawing a rectangle around it. You may wish to increase the
scale of your selection by drawing more rectangles. If you make a mis-
take, open the 'Zoom' dialog (top of 'Time string plot') and use an option.

The single-night data indicates a variation lasting about 0.1d, with non-
repetitive light curves. This may already be a sign of multi periodicity.
Notice too that within each night, the data are taken about every 0.003d
or 5 minutes apart. This figure is approximate because the coverage dif-
fers from night to night. The sampling theorem suggests that periods
shorter than 10 minutes should not be determined with such a data set.
To put it differently, the Nyquist frequency is about (0.5 % 1/0.003) or
167 cycles/day, abbreviated as c/d.

Furthermore, the data were taken one (or more) nights apart with day-
time gaps. Consequently, 1 c/d aliasing is expected.

To summarize:

(a) we suspect that frequencies near 10 c/d exist,
(b) the Nyquist frequency should be near 167 c¢/d, and
(c) 1 c/d aliasing may exist.
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4. Perform a Fourier analysis of the data: Spectral Window
Make sure that you have selected all the data. Click on the 'Fourier’ tab.
A new window opens. Let us now enter all the necessary parameters.

Title: Spectral Window
From: 0
To: 5
(remember that the spectral window is centered on 0 c/d
and calculates the pattern caused by the observing gaps).
Use weights: Keep 'none’
Calculations based on: Spectral window

Compact Mode: All
(since there are no huge gaps in the data)

Now press the central button: Calculate.

Let us look at the answers. In the line above the 'Calculate’ button, we
see that the highest peak occurs at frequency 0 with an amplitude of 1.
This has to be the answer for a spectral window.

Click on 'Display Graph’ on the bottom right. A plot window opens. You
can see the 1 c/d structure. Keep it in mind for the frequency search of
the stellar variations. The true frequencies of the star should also show
the pattern, but centered on the true frequencies.

My Fourier caloubation { F=6,%=1)

Figure 49: The spectral window.
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Close Fourier graph: Spectral Window.

5. Perform a Fourier analysis of the data: Periodic content of data
You are still in the Fourier window. If not, click on the 'Fourier’' tab. Let
us now enter all the necessary parameters:

Title: All data, incorrect zero-point
(the choice of this title will become clear below)

From: 0
Now see the Nyquist Frequency (167.778). Use this.

To: 167

Use weights: Keep 'none’
Calculations based on: Original data
Compact Mode: All

Now press the central button: Calculate.

Now a window opens asking you to select the zero-point shift. It allows
you to subtract the average brightness.

(a) INCORRECT OPTION:

Let us pick the incorrect option for the present data set. In the present
case, we select 'No’. This means that we assume that the measured av-
erage is not the true stellar average - this can indeed happen.

Let us look at the answers. In the line above the 'Calculate’ button, we
see that the highest peak occurs at frequency 0 with an amplitude of
0.4875. No, this is not the spectral window. It is a consequence of the
incorrect zero-point!

Do not include this frequency. Answer 'No’ to the question.

Click on 'Display Graph’ on the bottom right. A plot window opens. We
see two patterns, one centered on the frequency 0, the other one at 10.
Let us examine the structure at 0 in more detail: open the "Zoom' dialog
to the top of the plot and use option 'Select viewport’. Enter:
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Frequency min: -0.1
Frequency max: 5
Keep the chosen amplitudes. Click 'OK’.

Alldata, ncorrect zero-point { F=0, A=0.487544793 )

Figure 50: An example for using a wrong zero-point

You see the peak with an amplitude of 0.49 (twice the incorrect zero-
point value) near frequency 0. You also see the spectral window pattern
associated with this peak (Fig. 50).

Close the graph and redo the Fourier analysis with the correct zero-point.
(b) CORRECT OPTION:

We redo the calculation (calling it 'All data’) and say 'Yes'. Now the
highest amplitude occurs at 10.0011883 with an amplitude of 0.20124.

Answer the question: 'Do you want to include this frequency?’ with "Yes'.
It is now entered in the 'Fit’ window.

Look at the Fourier diagram again (button 'Display Graph' at bottom
right). A nice pattern of peaks around the frequency 10 is visible. A
decision to try out this frequency for a fit appears reasonable. Let us do
it.

Close the plot.
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Figure 51: The Fourier spectrum using the correct zero-point

6. A One-frequency fit.
Click on the 'Fit' tab (top). A window opens. You see the previously
suggested frequency.

(a) First calculation.

Select the first frequency F1 by clicking into the square to the left of
F1. A check mark appears. Click on 'Calculate’ at the bottom left. You
obtain the following result almost immediately:

Amplitude = 0.202266723 and Phase = 0.955286.

Near the top right you will see: Selected frequencies = 1. Yes, that is
true. Zero point: 0.2426. Yes, that is close to the average value al-
ready suggested by the program before the Fourier analysis. Residuals:
0.070878. We want to minimize this quantity, but we do not know what
the minimum value will be.

(b) Improve the frequency.

This option should be used carefully. Let us apply it (button bottom
middle). The frequency becomes 9.99988955, Amplitude = 0.202731263,
Phase = 0.501472. More importantly, the residuals have improved slightly.

7. Perform a Fourier analysis of the residuals
Let us see if the residuals contain more periodicities. Click on the 'Fourier’
tab.
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Title: Residuals, 1 frequency

From: 0

To: 167

Use weights: Keep 'none’

Calculations based on: Residuals at original (Note!)
Compact Mode: All

Now press the central button: Calculate.

A frequency of 14.5008529 and amplitude 0.0994119445 are found. In-
clude the frequency (for the next fit).

Examine the plot. It looks very good.

8. A Two-frequency fit.
Click on the 'Fit’ tab (top). Now select both F1 and F2. Probably you
only need to click into the square to the left of F2 to see check marks
next to both frequencies.

Click on 'Calculate’. The residuals decrease. Click on 'Improve all'. We
obtain frequencies of 10 and 14.5, amplitudes of 0.2 and 0.1, respectively,
and essentially zero residuals. That's it.

Do you want to see how the fit looks? Click on the 'Time string' tab
and select 'Display Graph'. The program cannot show the fit for several
nights. Therefore, select a single night (rectangle....). You now see the
excellent fit.
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Figure 52: The final fit.

3.2 Tutorial 2: Least-squares fitting of data including a periodic time shift

This tutorial provides a basic introduction in how to find a multiple frequency
solution to a data set, taking into account a periodic time shift. Such a periodic
time shift could be the result of orbital light-time effects.

1. Start Period04.

2. Import the data file.
To read in the data set, press the button 'Import time string’. A file-
selector dialog will be opened. Navigate to the directory that contains
the tutorial time strings and select the file 'Tutorial2.dat’.

In the next dialog, we are going to specify the properties of the columns
in the data file. The first column of our data file denotes time, whereas
the second column contains the observed magnitudes. Period04 should
already have assumed that, so just click on 'OK’.

Now press 'Display graph’ and examine the time string. You will observe
that a strong beating is present, which could be the result of two close
frequencies.

3. Extract the first frequency.
Click on the 'Fourier' tab. In the 'Fourier Calculation Settings' panel,
enter a title for the new Fourier spectrum. As you can see, the Nyquist
frequency of this time string is 139.806 cycles/day. Extend the upper
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limit of the frequency range to the lower integer part of this value (139).
Before you start the calculation, make sure that the option 'Original data’
is selected. Now press 'Calculate’.

A dialog will show up asking whether the zero point of magnitudes /
intensities should be subtracted. Press 'Yes'. After the calculation has
finished, the highest peak of the new spectrum is reported. Click on 'Yes'
to copy the values of the frequency peak into the Fit Module.

In the 'Fourier’ tab, press 'Display graph’ to inspect the plot of the Fourier
spectrum.

4. Calculate a first fit.
Switch to the 'Fit’ tab. You will notice that the new found frequency
has not yet been selected. Select frequency F1 and press 'Calculate’ to
improve amplitude and phase. Then, to improve all parameters press 'Im-
prove all'.

To check how good this solution fits the data, move to the "Time string’
tab and press 'Display graph’. As you see, there is still some work to do.

5. Find and fit further frequencies.
Switch back to the 'Fourier’ tab and calculate the next spectrum. From
now on the Fourier calculations should be based on the 'Residuals at orig-
inal’, so make sure that this option is selected.

In the Fit Module, select the newly found frequency and press 'Calculate’.
Then click on 'Improve all' to find the best least-squares solution.

Figure 53: The preliminary Four-frequency fit.

To detect further frequencies proceed as stated above. Extract two more
frequencies. The residuals will continue to decrease. Fig 53 shows the
frequency parameters you should obtain.
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6. Examining the data
Finally, after extraction of four frequencies the least-squares solution fits
quite well. Maximize the plot window and examine each night carefully.
You will notice that during the first and the last nights of the time string
the data points are shifted slightly to the right of the fit, whereas for the
nights in the middle of the data set the points are situated slightly left
of the fit. This may indicate that a periodic time shift is present with a
period that is approximately equal to the total length of the data set in
time, about 100 days. That corresponds to a frequency of 0.01 cycles/day.

Well, let us see if we can find any further frequencies. Switch to the
Fourier Module and extract the next frequency:

Frequency = 8.23515582 cycles/day and Amplitude = 0.00092585 mag-
nitudes.

This is quite interesting, isn't it? This frequency is quite close to the first
detected frequency (F1). The difference is only 0.010095 c/d which is
roughly the value for the frequency of the periodic time shift estimated
by visual inspection. It seems likely that the new frequency is an artefact
caused by a periodic time shift.

Now let us check whether our suspicion, viz. the presence of a periodic
time shift, can be confirmed. Leave the new frequency (F5) unselected
and do not change your four-frequency solution.

7. Activate the periodic time shift (PTS) mode.

Figure 54: The frequency panel in the periodic time shift mode.

Fitting a periodic time shift can only be done if Period04 runs in expert
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mode. To activate the expert mode, set the option 'Expert mode’ in the
File menu selected. A new menu entry, Options, will appear on the menu
bar. This menu contains the entry 'Set fitting function’ which provides
the alternative 'Standard formula with periodic time shift’. Select this
option. Now the program is enabled for calculating least-squares fits
including a periodic time shift. You will notice that the Fit Module has
slightly changed.

. Determining the periodic time shift parameters.

For non-linear fitting good starting values are essential. In general, initial
values for the periodic time shift parameters can be estimated from visual
inspection of the data, as we did before. Period04 also provides a tool
to search for starting values within a user-defined range of frequencies
and amplitudes by means of Monte Carlo shots. Press the button 'Search
PTS start values' to use this option.

Figure 55: The 'Search PTS start values' dialog.

The lower frequency limit is calculated from the time base of the data
set. You should not search for frequencies with lower values. The reason
is that for such frequencies the time base of the data is too short to allow
a reliable determination of the periodic time shift.

The number of shots refers to the number of initial parameter values that
are being tested. We will keep the default values. However, we will de-
select 'Use system time to initialize random generator’ in order to allow
the users to compare their results with the results given here. Press 'OK’
to start the calculation.

After the calculation has finished, the best set of starting values for the
periodic time shift parameters will be displayed (Frequency = 0.00975
cycles/day, Amplitude = 0.00104 days). Now let us improve these pa-
rameters by clicking on 'Improve PTS'.
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Figure 56: The fit after the determination of the periodic time shift parameters.

Finally, improve all frequencies together with the periodic time shift pa-
rameters by clicking on 'Improve all'. Do not use 'Calculate’, as for a
proper fit of a periodic time shift, the frequencies also have to be rede-
termined!

9. Extraction of further frequencies
Switch to the 'Fourier' tab and calculate a new Fourier spectrum. Press
'Display graph’ and have a look at the plot. It is obvious that the de-
tected frequency peak is not significant. Therefore, our analysis will stop
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Please note:

Let us suppose that you have found a statistically significant frequency.
In this case you should use 'Improve all' to obtain a new least-squares
solution. Furthermore, you do not have to use the 'Search PTS start val-
ues' tool again, as you already have good starting values for the periodic
time shift which can be improved.

The final solution
Your final fit using the four extracted frequencies and including a periodic
time shift should be:

Figure 58: The final solution.

The residual noise is 0.000999 magnitudes.

Click on the 'Time string’ tab and press the button 'Display graph’. You
will notice that the solution fits the data very well. After having applied
the periodic time shift, the data points are distributed uniformly on both
sides of the fit.

Now let us compare the final parameters to the values that had been used
to generate this time string:

# Frequency Amplitude Phase
PTSF 0.01 0.001 0.5

F1 8.24559 0.036872 0.19192
F2 8.86632 0.031595 0.20128
F3 8.51414 0.009952 0.81182
F4 7.42476 0.008187 0.76091

Desired residual noise: 0.001

Note the good agreement. The deviation from the initial values is caused
by noise.
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4. Using Period04

Within this section some of the key features of Period04 are discussed. In many
cases short step-by-step guides are given for easier comprehension.

4.1 Topics related to time string data
4.1.1 Importing time strings

1. Start the import
There are several different ways to start the import of a time string,
e.g. you can use the 'Import’ or 'Append’ buttons in the 'Time string’
folder. 'Import’ erases old project data and then loads the new time string.
'Append’ adds the time string to the current project without changing it
otherwise.

In addition, there are two more general approaches:

e The 'Import — time string’ command in the 'File’ menu.
(Shortcut 'Ctrl4+-T")
This command checks whether the project already contains time
string data. If no time points are found the file-selector dialog is
shown, otherwise the program will display the dialog shown in Fig 59.

Figure 59: The selection dialog for time string imports.

'Append a new time string’ simply adds a data set to your existing
time string without any further changes in the project. If you select
'Replace the old time string’ you have the possibility to instruct Pe-
riod04 not to erase the frequency data and/or the log.

e Importing a time string through the Data Manager (section 2.13).
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After having chosen one of the upper actions a file-selector is shown.
By default all files with the extension 'dat’ are shown. To display files
with another extension, please select 'All files’ in the file-selector dialog.
Navigate to the appropriate directory and select the file containing time
string data.

Set the file-format
The next step is to define the columns in your data file. For this purpose
the file-format dialog is opened.

Shobbraak,

Shabbrook
Zhohbirnok
Shobbook:
Shobbiook:
shobbiroak,
Shohbraok
Shobbroak
Shiobbroak:
Shobhbrook:
Shobbrook,

hbrook

Figure 60: The file-format dialog.

The dialog displays the first few lines of the selected file and provides an
initial guess for the column identification determined from the structure
of the columns in the file. The dialog shows the first four columns of the
file. In order to see the other columns, please use the scroll bar at the
bottom of the text box.

The following data can be read in by the program:

e Time

e Observed

e Adjusted

e Residuals to Observed
e Residuals to Adjusted
e (Calculated

e Point weight
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e 4 attributes and 4 weights assigned to these attributes *)

e Ignore (column will not be read in)

*) The names of the attributes depend on the program settings and can
be changed by clicking on the heading buttons in the Time String Mod-
ule. The default names are 'Date’, 'Observatory’, 'Observer’ and 'Other’.
In order to change the default names, the Period04 preferences file has
to be edited (see section 2.11).

3. Finally, press 'OK’

Please note:
Lines starting with '#', ;" or '%" will be treated as comment lines and are
ignored.

Additional options:

It is also possible to select multiple files in the file-selector dialog. In this
case, the program will ask the user for the file-format of the first data file. After
the specification of the file-format, a dialog will show up that allows to select
whether the program should apply the same file-format for all data files or to
show the file-format dialog for every file.

If the columns of most of your data files have a very special format, you
may find it useful to define a default file-format for reading in time strings. In
this case the file-format dialog will always propose the given default file-format
instead of trying to provide a guess about the file structure. This can be done
by editing the Period04 preferences file (see section 2.11).

4.1.2 Exporting time string data

1. Open the export dialog
To start the export you can either press the button 'Export time string’,
use the shortcut 'Alt+E’ or, if the program is running in expert mode,
start the Data Manager and select the option 'Export time string data’.
In any case the following dialog will show up:

2. Set the output format
The dialog contains two columns: the left text box lists all data columns
that can be exported. To the right there is another box, which defines
the structure of the columns in the resulting file. Now select the columns
to be exported from the list of available columns. Click on the button

© Austrian Academy of Sciences * Provided by the NASA Astrophysics Data System


http://adsabs.harvard.edu/abs/2005CoAst.146...53L

P. Lenz and M. Breger 121

Res iduals (Dbserved)
Res iduals. (Adjusted)

Figure 61: The time string export dialog.

'Add’ to add these columns to the list on the right. If you want to remove
a column that you have added before, simply select the column name in
the 'Columns to export’ list and press 'Remove’. Finally, when you have
finished your selection, press 'OK'.

Figure 62: The time string export dialog with an example of a selection.

In the example shown in Fig. 62, we have chosen the columns "Time’,
'Observed’, 'Calculated’, 'Observer’ and the weights assigned to the sub-
strings of attribute 'Observer’ for export.
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3. Choose a file name
Now, a file chooser will ask you for a name for the file. Enter a file name
and press 'Export’ to start the export of the data.

4.1.3 Creating artificial data

It is easy to generate an equally-spaced artificial data set using Period04. First,
make sure that there is a set of active frequencies — or at least one active
frequency — in the frequency list of the Fit Module. The current fit will be used
for the calculation of magnitude/intensity of the artificial data.

1. Select 'Create artificial data’ in the Special menu
The 'Create artificial data’ dialog will appear.

Figure 63: The 'Create artificial data’ dialog.

2. Setting the time range(s)
There are two options to define the start and end times of the time series
that will be generated:
e Definition of start and end time by the given input fields.
e Using the button 'Read time ranges from file’ for reading the defi-
nitions of start and end times from a file.

The latter option has the advantage that artificial data for an arbitrary
number of different start and end times can be created right away. Please
make sure that the file obeys the following format conditions:
e first column: start time
e second column: end time
3. Calculation settings

Now you have to define the step size. By default a value of 1/(20% Fypqz)
is given, which provides a good sampling even for the highest frequency.
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The input field 'Leading/trailing time' gives you the possibility to extend
the time ranges by a certain value.

4. Start calculation and output of data
Click on the button 'Write data to the following file ..." and choose a file
in which the data should be written. If the file already exists, you will be
prompted whether you want to append the data to the file, replace the
file or to cancel the task.

4.2 Topics related to Fourier calculations
4.2.1 Calculation of Fourier spectra

Let us suppose that you have already read in a time string.

1. Click on the 'Fourier’ tab.
As you can see, in the upper part of the window the settings for the
Fourier calculation can be defined.

2. Choose a title for the Fourier spectrum.

3. Define the frequency range for the spectrum.
Make sure that the upper frequency bound does not exceed the Nyquist
frequency.

4. Choose a step rate.
This value defines the step size in frequency. Usually the step rate quality
'High' provides a good sampling.

5. If you want to use weighted data, set and activate the appropriate weights.
See section 4.4.1 for more information on this topic.

6. Choose the type of data you want to use.
If this is the first frequency to be extracted from the data set, 'Original
data’ is the right choice. For subsequent frequencies you would select
‘Residuals at original’. If you adjusted the zero-points of the time string
select 'Adjusted’ instead of 'Original’.

7. Select the compact mode.
If you want to reduce the output (the number of data points) of the
Fourier calculation, select 'Peaks only'. If this option is selected only the
local extrema of the spectrum will be saved.

8. Press 'Calculate’ to start the calculation.
A dialog will be opened and you will be asked whether you want to
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subtract the zero point of the magnitudes/intensities. Press 'Yes'. While
the program is calculating the 'Calculating’ tab is being shown. It reports
the progress of the calculation and shows the chosen settings. By clicking
on the button 'Cancel Calculation’ the calculation can be stopped.

9. After the calculation has been finished, a dialog is opened that informs
you about the value of the highest peak and asks you if you want to
include this frequency. Press 'Yes' to add the frequency to the frequency
list in the 'Fit' tab.

10. Inspect the Fourier spectrum visually by clicking on 'Display Graph'. The
next step is to make a least-squares fit. See 'Calculation of least-squares
fits’ for further details.

11. For extracting further frequencies proceed as stated above except that
you choose 'Residuals at original’ instead of 'Original data’.

4.2.2 Significance of frequencies

Every measurement is affected by noise that may be generated by many sources
(e.g., observations, instrumentation, undetected frequencies). For Fourier spec-
tra, noise has the annoying effect that a peak that has been found may not be
real.

The signal to noise ratio

Therefore, a criterion is needed to ensure that the signal is a real feature.
Empirical results from observational analyses by Breger et al. (1993) and nu-
merical simulations from Kuschnig et al. (1997) have shown that the ratio
between signal and noise in amplitude should not be lower than 4.0 for high
significance.

What is the signal?
As signal we define either the amplitude of the respective peak in the Fourier
spectrum or the amplitude of the least-squares solution for the peak.

What is the noise?
The noise is defined as the average amplitude in a frequency range that encloses
the detected peak. The noise may be calculated before or after prewhitening
the peak. The choice is beyond the scope of this manual.

© Austrian Academy of Sciences * Provided by the NASA Astrophysics Data System


http://adsabs.harvard.edu/abs/2005CoAst.146...53L

P. Lenz and M. Breger 125

Checking the significance of a frequency

Let us assume that you have calculated a Fourier spectrum and detected a
new peak.

1. Select 'Calculate noise at frequency’ in the 'Special’ menu.
By default the program loads the last frequency value from the frequency
list in the Fit Module into the frequency field of the dialog. If you want to
calculate the noise for an other frequency, type the new frequency value
into the frequency field.

2. Define the box size for the noise calculation.
This value specifies the frequency range [frequency—%, frequency+
b"‘gﬂ] which is being used for the calculation of the noise.

3. Choose a step rate.
Usually the step rate quality 'High’ provides a very good sampling.

4. Select the type of data to use for the noise calculation.
In most cases 'Residuals at original’ is what you need, unless you work
with adjusted data.

5. Press 'Calculate’ to start the calculation.
After the calculation has been finished, the noise result will be displayed
in the text area in the lower part of the window. If the frequency has
been selected from the combo-box then even the signal to noise ratio will
be shown.

Period04 also contains the possibility to calculate a noise spectrum. See
section 2.8.20 for more details.
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4.3 Topics related to least-squares calculations
4.3.1 Calculation of least-squares fits

This is a step-by-step guide for calculating least-squares fits using the standard
fitting formula:

fit)y=2+ Z A;sin (27 (Qt + ®;))

T
1. Click on the 'Fit’ tab.

2. After you have extracted a frequency by means of a Fourier calculation,
the frequency and amplitude are added to the frequency list. You may
also enter own frequency values.

3. Activate the new frequency by selecting the check box at the beginning
of the frequency line.

4. Select the type of data you want to use. By default 'Original data’ is
selected.

5. If you want to use weighted data, set the appropriate weights. See sec-
tion 4.4.1 for more information on this topic.

6. Press 'Calculate’ to improve amplitude and phase.

7. Press 'Improve all’ to improve all parameters, including the value of the
frequency.

Period04 does also allow for more sophisticated least-squares fits:

¢ Improve special:
If you want to define a specific selection of parameters that should be
improved, then choose this option.

e Calculate amplitude/phase variations:
Use this if you suspect that the amplitude and/or phase of a parameter
is variable in different substrings.

e When the expert mode is active it is possible to calculate least-squares fits

that include a periodic time shift. See section 4.3.3 for more information
on this topic.
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4.3.2 Calculation of amplitude/phase variations

If you suspect that the amplitude and/or phase of a parameter is variable within
different substrings (e.g., representing different years), you might consider to
use this tool.

1. Prerequisites:
Let us assume that you have a set of frequencies and a certain subdivision
of your time string in the attribute 'Date’. By calculating a least-squares
fit for each substring separately you realized that the amplitude of a
frequency might be variable.

Figure 64: In this example a time string has been subdivided in attribute 'Date’.

2. Press the button 'Calculate amplitude/phase variations’ in the Fit Mod-
ule.

3. In the dialog, select the attribute in which the subdivision of the time
string is located.

4. Choose the type of variation: 'amplitude variation’, 'phase variation' or
'amplitude and phase variations'.

5. Select the frequency that shows the amplitude variation.

6. Decide whether you want to improve 'all amplitudes and phases’ while
keeping the frequencies fixed, or to define a special selection of variable
parameters. If you prefer the latter, then click on 'special’ to open a
dialog for the definition of the selection.

7. Press 'Calculate’ to start the calculation.
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8. After the calculation has finished the results are displayed in the text box
below.

4.3.3 Using the periodic time shift mode

In order to account for light time effects, Period04 does also allow to include
a periodic time shift in your least-squares calculations. In this case the fitting
formula is extended in the following way:

fity=72+ Z A sin (27 (Q; [t + aypes sin (27 (wpest + Gpes))] + i)

The periodic time shift parameters are labeled with the subscript 'pts’. Z
denotes the zero point of f(t) and A;, €; and ®; the parameters of frequency i.

Please note:
This calculation mode can only be selected when the expert mode is activated.

Let us assume that you already read in a data set and extracted some
frequencies. The visual inspection seems to indicate that the times are shifted
with a certain period.

1. Select the periodic time shift mode
First, activate the expert mode by selecting 'Expert mode' in the 'File’
menu. You will notice that a new menu, 'Options’, has appeared. This
menu contains the entry 'Set fitting function' which provides two choices:
Standard formula and Standard formula with periodic time shift. Click
on the latter.

2. Set parameters for the periodic time shift
By inspection of your data you might already have a rough estimate of
frequency and amplitude for the periodic time shift. You can either enter
these values into the respective field directly, or use the 'Search PTS start
values' button to search for a good start value for the periodic time shift
parameters within a user-defined range of frequencies and amplitudes.

The lower frequency limit is calculated from the time base of the data
set. You should not search for frequencies with lower values since for
these frequencies the time base of the data is too short to allow a reliable
determination of the periodic time shift.

The number of shots refers to the number of initial parameter values that
are being tested.
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Figure 65: The 'Search PTS start values' dialog.

3. Improving the parameters and the fit
The next step is to improve the periodic time shift parameters by means of
a least-squares fit. In order to start this calculation, press 'Improve PTS'.
Please note that the common frequency parameters will be kept fixed
during this calculation.

Now it is time to make a least-squares fit that considers all parameters
as variable. For this purpose press 'Improve all'. Do not use 'Calculate’,
as for a proper fit of a periodic time shift, the frequencies also have to
be redetermined!

Please note:
If the start values are not good enough it might occur that the least-squares
algorithm gets trapped in a false local minimum. Generally, nonlinear fitting
requires some judgment from the user!

Please see section 3.2 for a tutorial that explains the same matter using an
example time string.
4.3.4 Estimation of uncertainties

Period04 provides several tools to calculate the uncertainties of the parameters
of a fit:

e Calculation of uncertainties from the error matrix of a least-squares cal-
culation

o Monte Carlo Simulation
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e Uncertainties calculated from analytically derived formulae assuming an
ideal case.

Please note:
The errors of frequency and phase are correlated. However, by an appropriate
choice of a zero point in time the uncertainties for frequency and phase can be
decoupled. This is the case when

=1

(Breger et al., 1999). It is very likely that your data set does not fulfill this
condition. Therefore, Period04 provides the possibility to shift the data set
by the required value in time, for the purpose of determining the uncorrelated
parameter uncertainties when the standard fitting formula is being used.

1. Calculation of uncertainties from the error matrix of a least-squares
calculation
Period04 applies the curfit routine from Bevington (1969), which is a
Levenberg-Marquardt non-linear least-squares fitting procedure. As a
by-product of least-squares fits an error matrix is available from which
parameter uncertainties can be calculated. In some cases though (i.e.,
when the error matrix is ill-conditioned) this method does not provide a
good estimate of the uncertainties. In order to ensure that the calculated
uncertainties are reliable, Period04 performs checks for these cases.

The output of common least-squares fits are correlated uncertainties.
When the standard fitting formula is being used, Period04 additionally
offers the possibility to calculate uncorrelated uncertainties.

To calculate the uncertainties of the fit parameters, press 'Calculate LS
uncertainties' in the 'Goodness of Fit' tab. If you improved frequencies
and phases simultaneously, a dialog will ask you whether you want to un-
couple the uncertainties of frequency and phase (in other words: whether
you want to calculate correlated or uncorrelated uncertainties). After you
made your choice, the uncertainties will be displayed in the text box.

2. Monte Carlo Simulation
Monte Carlo simulations are a very reliable way to determine parameter
uncertainties. The principle idea is to repeat an experiment (in our case
the optimization routine) on a generated set of samples.
For the Monte Carlo simulation Period04 generates a set of time strings.
Each data set is created as follows:
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e The times of the data points are the same as for the original time
string.

e The magnitudes of the data points are the magnitudes predicted by
the last fit plus Gaussian noise.

For every data set a least-squares calculation will be done. Based on the
distribution of fit parameters the program calculates the uncertainties of
the parameters.

A short step-by-step guide for making Monte Carlo simulations:

e The Monte Carlo simulation will use the same settings that have
been used for the last fit. So if you want to determine the uncer-
tainties for all parameters, you will have to make a least-squares
calculation with all parameters variable first.

e Now click on '"Monte Carlo Simulation’ in the 'Goodness of Fit' tab.
In the dialog you have to define some settings for the simulation:

Figure 66: The 'Monte Carlo Simulation’ dialog.

Number of processes
A 'process’ consists of the creation of time string data and a
least-squares calculation to determine the fit parameters. A low
number of processes results in a bad estimation of the uncer-
tainties. Therefore, to obtain reliable results, a high number of
processes is necessary.

Uncouple Frequency and Phase Uncertainties
If this option is selected, the time string will be shifted in time
so that the 'average time' is zero. In this case the frequency
and phase uncertainties are no longer correlated. This check
box will only be visible if this option might be useful, i.e., when
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both frequency and phase parameters are fitted using the stan-
dard fitting formula.

Use system time to initialize random generator
If this option is selected the random number generator that is
used to create the time string data sets will be initialized with
the current system time.

e Press 'OK’ to start the calculations. Depending on the number of
time points and the number of processes this might be a quite time
consuming task.

3. Uncertainties calculated from analytically derived formulae assum-
ing an ideal case
Based on some assumptions one can derive a formula for the uncertain-
ties in frequency, amplitude and phase. See Breger et al. (1999) for the
derivation based on a mono periodic fit. If cross terms can be neglected
then the following equations can also be applied for each pulsation fre-

quency separately:
6 1 o(m)
U= VNT e

o(a) = %J(m)

N is the number of time points, T is the time length of the data set,
o(m) denotes the residuals from the fit and a refers to the amplitude of
the frequency.

To show these parameter uncertainties, select 'Show analytical uncertain-
ties' in the 'Special’ menu.

Please note:

This option is only available when using the standard fitting formula.
4.4  General topics
4.4.1 Using weights

Period04 does also handle weighted data. It recognizes three different types of
weights:
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e Point weight
Each measurement has its own weight.

e Deviation weight
Filtering of poor data points.

e Attribute weights
Weights assigned to substrings of each of the four attributes (Date, Ob-
server,...)

In order to use weights the user has to set or read in weights AND to ac-
tivate them for calculations. This can be done in the "Weight selection dialog’
which can be accessed by the 'Special’ menu or via the shortcut 'Ctrl+W'.

Figure 67: The "Weight selection’ dialog

Using point weights:

As 'point weight' we denote weights that are assigned to each of your data
points. Point weights can only be read in along with time string data. To
include these data proceed as described here:

1. Click on the button 'Import time string’ and select the file that contains
your data set in the file-selector dialog.

2. Now another dialog appears. It will show the columns in your data file
and asks you to label these columns correctly. Specify the column that
contains the point weight data as 'Pnt.weight’ and select appropriate
labels for the other columns too — at least 'Time' and 'Observed' are
required. Press 'OK".
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3. Although your data set has been read in, the program does not yet in-
clude the point weights in calculations. They have to be activated in the
'Weight selection dialog' first. So open the dialog, select 'Point weight'’
and press 'OK'.

From this point the program will use the weighted data until you deselect
this option.

Using deviation weights:

The deviation weights are calculated from the residuals of data points:

residual = |observed — calculated|

1.0 if residual < cutoff
deviati ight = 2
eviation weig <%) if residual > cutoff

In order to use deviation weights open the 'Weight selection dialog’, select
'Deviation weight' and set an appropriate cutoff value.

Using attribute weights:

Each of the four list boxes in the "Time string’ tab represents an attribute.
The default names of these attributes are 'Date’, 'Observatory’, 'Observer’ and
'Other’. If the time string has been subdivided in at least one attribute it is
possible to give each substring a certain weight.

1. If you have not done so already, read in a time string.

2. Subdivide the time string. Let us assume that you divided the time string
into several substrings in the attribute 'Date’.

3. Select a substring for which you want to change the weight. Open the
'Edit substring properties’ menu by pressing the 'Edit substring’ button at
the bottom of the 'Date’ list box. You can also access this dialog directly
via the pop-up menu.

4. Type the new weight value into the respective field and press 'OK’.

5. To enable the weights assigned to substrings of attribute 'Date’, open
the 'Weight selection dialog’, select 'Date’ and press 'OK’. Now these
weights will be included in all calculations.
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5. Copyright notice

Copyright (©2004-2005 Patrick Lenz, Institute of Astronomy, University of Vi-
enna

Permission to use, copy, modify, and distribute this software and its doc-
umentation for any purpose is hereby granted without fee, provided that the
above copyright notice, author statement and this permission notice appear in
all copies of this software and related documentation.

THE SOFTWARE IS PROVIDED 'AS-IS" AND WITHOUT WARRANTY
OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITH-
OUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FIT-
NESS FOR A PARTICULAR PURPOSE. IN NO EVENT SHALL THE INSTI-
TUTE OF ASTRONOMY OR THE UNIVERSITY OF VIENNA OR PATRICK
LENZ BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR CON-
SEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSO-
EVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER
OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY
THEORY OF LIABILITY, ARISING OUT OF OR IN CONNECTION WITH
THE USE OR PERFORMANCE OF THIS SOFTWARE.

Period04 is based on Period98 (Copyright (©1996-1998 by Martin Sperl).

5.1 Third party software

Period04 makes use of the following third party software:

e Scientific Graphics Toolkit (SGT) - an open source library of Java graph-
ics classes.
The SGT is provided by NOAA (National Oceanic and Atmospheric Ad-
ministration) for full, free and open release and is available at
http:// www.epic.noaa.gov/java/sgt/sgt_download.shtml.

e EpsGraphics2D - an open source package for creating high quality EPS
graphics
Copyright (©2001-2004 by Paul James Mutton
http://www jibble.org/epsgraphics/

e JavaHelp™2.0.01
Copyright 2003 Sun Microsystems, Inc.
http://java.sun.com/products/javahelp
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